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About this Document
This document is organized into the following sections:

Section Description

Basic Tasks for Reviewing an Invisalign® Full 
Treatment Plan

Includes simple tasks that enable you to review 
the treatment plan quickly and easily. This section 
is appropriate for doctors who are new to 
Invisalign.

Intermediate Tasks for Reviewing a ClinCheck 
Treatment Plan

Includes additional capabilities that provide you 
with more information for reviewing the treatment 
plan. This section is intended for doctors who 
have some experience with Invisalign and want to 
take advantage of additional ClinCheck 
capabilities.

Using Advanced Capabilities Includes descriptions of capabilities for advanced 
users.

Treatment Plan Review with Invisalign Assist Describes the differences between Invisalign Full 
and Invisalign Assist treatment plan review.

Configuration Requirements Describes requirements for running the ClinCheck 
software.

Installing the ClinCheck Software Provides installation instructions.
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Introduction to the ClinCheck® Software
The ClinCheck software is used for viewing a ClinCheck treatment plan that is developed from a 
doctor’s orthodontic prescription. The ClinCheck software can also be used to exchange information 
with Align about any changes the doctor would like to make to the treatment plan. When the doctor 
approves a treatment plan, aligners are manufactured and sent to the doctor to use in an Invisalign 
treatment.

Opening a ClinCheck Treatment Plan from the Invisalign®

Doctor Site
To open a ClinCheck treatment plan from the Invisalign Doctor site, complete the following steps:

1. Open your browser.

2. Go to the invisalign.com website.

3. Click on the I am a doctor link.

Figure 1. Invisalign.com web site
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4. Log in to the Invisalign Doctor Site.

Figure 2. Invisalign Doctor Site login screen
5. Type the Username and Password that you were given in the Clear Essentials I course, then click 

on the Login button.
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6. On the Patient List page, click on the bar for a patient whose status is Review ClinCheck treatment 
plan.

Figure 3. Patient List page
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7. On the Patient File page, click on the View ClinCheck Plan button on the Treatment Lifecycle tab.

Figure 4. Patient File page
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ClinCheck Treatment Plan Example for Invisalign Full

Figure 5. ClinCheck treatment plan
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Basic Tasks for Invisalign Full Treatment Plan Review
ClinCheck Menu Bar
This section describes individual menus on the menu bar.

Menu bar

Figure 6. ClinCheck menu bar
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Using ClinCheck Menus

Menu Concepts

The File menu enables you to perform general 
tasks:

� Opening a treatment plan
� Printing various views
� Choosing print options
� Viewing recent treatment plans
� Specify display preferences
� Exiting from the ClinCheck software

The View menu provides multiple choices for 
viewing the 3-D model, and an option to view past 
treatment plans for the same patient.

The Advanced Tools menu enables you to gain 
access to additional features from the ClinCheck 
toolbar, and open the Custom Attachments and
Precision Cuts Interfaces. The Grid and 
Superimposition buttons are loaded onto the
toolbar and the Custom Attachments and 
Precision Cuts links are added to the Changes 
panel, so you can use these features whenever 
you want.

Figure 8. View menu

Figure 9. Advanced Tools menu

Figure 7. File menu
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Menu Concepts

The Export menu enables you to create visual 
output in formats that you can print and save 
(screenshots) or show to your patients so they can 
view their treatment from beginning to end 
(movies).

The Help menu enables you to find more 
information about the ClinCheck software. 

The Help Topics menu provides short movies 
about how to do key tasks with the ClinCheck 
software. 

Check for Updates provides information about 
updates that are available for the current version 
of your software.

About ClinCheck provides key technical 
information about the software and information 
about how to contact customer support.

Figure 12. Right-Click menu

The right-click menu appears when you place your 
cursor anywhere in the ClinCheck display area 
and click the right button on your mouse. The 
menu enables you to hide the upper or lower jaw, 
to select a view to display, or print a screenshot of 
the display. The menu disappears when you left-
click anywhere.

Figure 10. Export menu

Figure 11. Help menu
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Using the ClinCheck Toolbar

� Use the Rotation/Translation button to move the ClinCheck 3-D model.
� Use the Basic buttons to perform basic tasks for ClinCheck treatment plan review.
� Use the Basic Views buttons to view the ClinCheck 3-D model from different angles.

Rotation/
Translation

Button Basic Buttons Basic Views

Figure 13. The ClinCheck toolbar
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Using the Rotation/Translation Control Button
The first button on the toolbar toggles between rotation control and translation control.

Example Model Button

Figure 14. Rotated 3-D model with rotation control 
cursor shown

The Rotation Control button enables you to move 
the 3-D model so you can inspect the surfaces 
from any direction. If you see crossed arrows 
(Translation Control Button) instead of a circular
arrow, click on the button. The circular arrow 
appears.

� Click in the ClinCheck display area and move 
the cursor in any direction. The model rotates 
in the direction the cursor moves. 

� Note: Clicking on the model is optional. 

Figure 15. 3-D model with the translation cursor 
shown

The Translation Control button enables you to 
move the 3-D model to another part of the display 
area without rotating it. If you see a circular arrow 
(Rotation Control Button) instead of crossed
arrows on the button, click on the button. The 
crossed arrows appear.

� Click anywhere on the 3-D model and drag the 
model in any direction.

� Note: You must click on the 3-D model in 
order to move the model.
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Using Basic Buttons

Buttons Concepts

Figure 16. Basic Buttons

The basic buttons on the ClinCheck toolbar  
include the following:

� Attach =  Attachments

� Num = Numbering

� IPR = Interproximal Reduction

� Over = Overcorrection

� Erupt = Erupting teeth

Example Model Button

Figure 17. 3-D Model with Attachments Shown

The Attachment button enables you to hide or 
display attachments on the 3-D model. By default, 
the attachments are displayed.
� To hide attachments, click on the button. The 

button turns gray.
� To display attachments, click on the button

again. The button turns blue.
Attachments are displayed by default as pink 
shapes on the teeth. You can change the 
attachment color by selecting File – Preferences.
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Example Model Button

Figure 18. 3-D Model with Numbering Shown

The Numbering button enables you to hide or 
display tooth numbers on the 3-D model. Numbers 
appear on the teeth in the model. 
� To display numbers, click on the Numbering

button. The button turns blue.
� To hide numbers, click the button again. The 

button turns gray.
� Note: You can change the numbering system 

in the Invisalign Doctor Site clinical 
preferences. The numbering system you 
choose displays on the ClinCheck model and 
on the Invisalign Doctor Site.You can choose 
the Universal, Palmer, or FDI numbering 
system.

Figure 19. 3-D Model with IPR Indicators Shown

The IPR button enables you to hide or display IPR 
information. IPR information is displayed by 
default.
� To hide IPR indicators, click on the button. The 

button turns gray and the indicators disappear. 
� To display IPR indicators, click on the button

again. The button turns blue and the IPR 
indicators are displayed.

The IPR indicators change color, depending upon 
the stage.

White Planned IPR

Yellow IPR complete by the 
current stage

Gray IPR finished
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Example Button

Figure 20. Overcorrection example

The Overcorrection button enables you to view 
overcorrection in the staging panel. This button is 
active only if overcorrection is present. 

� To hide overcorrection on the staging panel, 
click on the Overcorrection button.

� To display overcorrection, click the 
Overcorrection button again. 

The red box shows overcorrection from stage 7 to 
9 for the upper aligner and from stage 6 to 9 for 
the bottom aligner. Overcorrection is shown in 
brown. The Overcorrection button shows the 
stages of overcorrection that were ordered in the 
prescription.

When you play the ClinCheck animation, the white 
bar sweeps across the staging panel. If you click 
the Overcorrection button off, the movie will stop 
at the stage before overcorrection so you can see 
the final position without overcorrection.
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Example Model Button

Figure 21. 3-D model showing an erupted tooth

The Erupting Teeth button enables you to see the 
erupting teeth in an Invisalign Teen patient. The 
button is enabled when there are erupting teeth in 
the treatment plan.

� To hide erupting teeth, click on the Erupting 
Teeth button.

� To display erupting teeth, click on the Erupting 
Teeth button again.

The red box shows the erupting tooth.
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Using Basic Views Buttons

Buttons Concepts

Figure 22. Buttons for selecting the basic views for 
displaying the 3-D model

The Basic Views buttons shows the following 
views of the 3-D model:

� Occlusal mandibular
� Left buccal
� Anterior
� Right buccal
� Occlusal maxillary

Zooming

Controls Concepts and Procedures

    
Figure 23. Zoom Controller with vertical or 
horizontal flags

The Zoom Controller enlarges or reduces the size 
of the 3-D model so you can see more or less 
detail, respectively.

� Click on the plus sign to enlarge the model.

� Click on the minus sign to reduce the size of 
the model.

� Place your cursor over the flag to move the 
flag to a horizontal position. Click on the flag 
and move it to the zoom factor you need. To 
return to the default zoom factor (200%), click 
on the Anterior View button in the Basic Views 
on the ClinCheck toolbar.
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Playing the ClinCheck Animation

Animation Control Bar Concepts and Procedures

You can play an animation of the ClinCheck 
treatment plan, showing tooth movement from 
the initial state to the final tooth position. The 
animation is based on stages.

A stage is a discrete step in a ClinCheck 
treatment plan to accomplish a specified tooth
movement for one or both arches. Each stage 
of tooth movement will correspond to an 
aligner that will be manufactured for your 
patient.

One 3-D model depicts the tooth position for 
each stage. Viewed in sequence, the series of 
images creates a 3-D animation of tooth 
movement from beginning to end.

To view the animation, use the Animation 
Control Bar.

� To play all stages, click on the Play button.
� To pause at any stage, click on the Pause

button.
� To go to the first stage, click on the left 

button.
� To go to the last stage, click on the right 

button.
� To go to a specific stage, drag the 

scrubber to the stage.

Go to 
first 

stage

Play Scrubber

Go to 
last 

stage

Pause

Figure 24. Animation controls

Figure 25. Pause button
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Using the 2-D Panels

Opening and Closing the 2-D Tabbed Panels

Controls Concepts

Figure 26. 2-D control tabs

The 2-D control tabs are located at the upper right 
corner of the 2-D tabbed panel. They control 
whether the panel is open, expanded, or 
collapsed.

Collapsing the Panels

Panels Procedure

Figure 27. Collapsed 2-D panels

� To fully collapse the 2-D tabbed panels, click 
on the left arrow so that the arrow is pointing 
down. The tabs stay at the upper right corner 
of the ClinCheck display area, creating more 
space for the 3-D model. To open a panel, 
click on the appropriate tab.
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Opening the Panels

Panels Procedure

Figure 28. Open 2-D panel

� To open the panels, click on the left button so 
that the arrow is pointing up.
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Expanding the Panels

Panels Procedure

� To expand the panels, 
click on the right button 
so that the arrow points 
to the right.

Figure 29. Expanded 2-D panel
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Using the Treatment Panel to Review the Invisalign Treatment Overview
The Treatment tab contains information about the treatment plan, including the following:

� Estimated Treatment Time
� Treatment Overview

� Attachment and IPR information
� Aligner Features

� Tooth Movement Assessment
You can navigate to the sections of the Invisalign Treatment Overview by clicking the links at the top of 
the panel. 

Panel Concepts

Figure 30. Navigation links, Estimated Treatment 
Time, and Treatment Overview sections of the 
Treatment panel

� The initial view of the panel begins with links 
for navigating to different areas in the 
Treatment panel: Estimated Treatment Time,
Treatment Overview, Movement Assessment.

� The next section contains the Estimated 
Treatment Time section, which gives some 
guidance on the approximate number of 
months your patient may be in treatment. This 
is based on the number of stages in the 
ClinCheck treatment plan plus a 50 percent 
buffer in case refinement is needed.

� The following section contains an example of a
Treatment Overview for an Invisalign Full 
treatment. This shows the application of the 
treatment’s clinical protocols as requested on 
your prescription. 
� Active Aligner Stages shows the stages 

that use active aligners in each arch. If 
present in the treatment, passive, and 
overcorrection aligners, as well as lingual 
attachments are shown.

� A 2-D representation of patient’s teeth 
shows the amount of IPR, the stages 
before which IPR takes place, the teeth 
that will have attachments, and missing 
teeth.
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Panel Concepts

Figure 31. Aligner Features section of the 
Treatment panel

The second page of the Treatment panel shows 
the aligner features needed to for the treatment.
The 2-D diagram shows a flattened version of the 
aligners so you can see the features on both sides 
of the aligners.
Symbols show the following:
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Panel Concepts

Figure 32. Movement Assessment section of the
Treatment panel

The red box contains the Invisalign Tooth 
Movement Assessment section of the Treatment 
panel.
Symbols show the following:

Click on the “Learn more” link, which goes to the 
Aligntech Institute site, to find more information 
about these movements. 
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Using the Comments Tab to Review Invisalign Comment to You

Panel Concepts

Figure 33. Comments panel

The Comments panel contains the most recent 
communication from Invisalign technicians
regarding your ClinCheck treatment plan. 
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Approving a ClinCheck treatment plan

Buttons Concepts and Procedures

Figure 34. Cancel and Approve buttons

� To finalize a ClinCheck treatment plan, click
on the Approve button in the ClinCheck 
window. Approving a treatment plan initiates 
the process of manufacturing aligners, and
constitutes an agreement to pay for the 
aligners.

� To cancel the order for aligners, based on the 
treatment plan, click on the Cancel button.
When you cancel an order, you are not 
responsible for any payment. If you wish to 
resubmit an order at this time, you must begin 
the process over again.
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Intermediate Tasks for Reviewing a ClinCheck
Treatment Plan
Specifying Changes to the Treatment Plan

Panel Concepts and Procedures

Figure 35. Changes panel

To change a ClinCheck treatment plan based on 
your review and comments provided by Align 
Technology, complete the following steps:

1. Click on the Changes tab.

2. Type your comments in the upper box.

For effective communication with the Invisalign
technician, do the following:

1. Read the ClinCheck comments from the 
technician.

2. Identify the view on which you are basing your 
request.

3. Describe the tooth – for example: upper right 
central incisor. If you click on a numbered 
tooth on the ClinCheck model, the number 
appears in your comments.

4. Provide your instructions in bullets and 
number them.

Type your changes
to your treatment plan 

into this box.

This box contains changes 
generated by the Attachments and 

Precision Cuts interfaces.

This area contains a complete history 
of your changes and the comments 

from the Invisalign technician.
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Specifying Display Settings

The Display Setting dialog has three tabs that show your current preference choices and enable you to 
set new preferences.

Display Setting Concepts and Procedures

Figure 36. File – Display Setting – Color tab

Colors tab – Enables you to view and set 
background and attachment colors.

When you first open the ClinCheck treatment plan, 
you will see the default colors for the active 
window’s shaded background, tooth numbering, 
and attachments.

� To change colors, click on a color box and you 
will see a color chooser. Click on the color you 
want. 

� To return to the default color, click on the 
Default button.
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Display Setting Concepts and Procedures

View tab – Enables you view and set values for 
the display, type of rotation, default zoom factors, 
and degree of tooth shading.

Figure 37. Display Preferences – View tab
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Display Setting Concepts and Procedures

Movies tab– Enables you to specify information 
for movie output. The movies are standalone 
versions of the ClinCheck animation, which you 
can store for your own reference and, if you like, 
show to patients to help them visualize their 
Invisalign treatment. See Using Advanced 
Capabilities.

Figure 38. Display Preferenced – Movies tab
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Using the View Menu

View Menu Concepts

The View – Secondary View menu enables you to 
select additional views to augment the basic 
views. 

The View – Gallery menu enables you to choose 
the number of views you want to see in the 
ClinCheck display area. You can view and 
manipulate any of the models in the gallery view 
independently. This capability enables you to 
examine and compare the model from different 
viewpoints.

Figure 39. View – Secondary View menu

Figure 40. View – Gallery menu
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Gaining Access to Past Treatment Plans 

Menu Concepts and Procedures

� This feature shows a past history of all 
ClinCheck treatment plans posted for the 
patient – initial, mid-course corrections, 
refinements. 

� To view previous treatment plans for the 
patient, select Past Treatment Plans, and then 
select the treatment plan you want to see.Figure 41. View – Past Treatment Plans menu
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Using Advanced Capabilities
Using Advanced Features in the File Menu

Dialog Concepts and Procedures

Figure 42. File – Open dialog

The Open selection on the File menu enables you 
to open any filename.adf file on your computer.
The .adf file contains a ClinCheck treatment plan.

1. When you select File – Open, the standard 
Windows dialog appears.

2. Navigate to a ClinCheck treatment plan you 
want to view and select it. Note that the file 
type is .adf.

3. Click on the Open button. 
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Dialog Concepts and Procedures

The File – Print Dialog enables you to select any 
of the following options:

� Current View – Prints a view of the current 
model.

� 2 x 3 Gallery View – Prints the 2 x 3 Gallery 
View.

� Changes Tab – Prints a summary of the 
changes you have typed in the Changes 
panel.

� Staging Tab – Prints a complete summary of 
the Staging Panel graph.

� Treatment Tab – Prints the Invisalign 
Treatment Overview.

Figure 44. File – Print Setup dialog

When you select File – Print Setup, the standard 
Windows dialog appears.

� Type the required information and click on the 
OK button.

Figure 43. Print dialog
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File – Recent Items

Menu Concepts and Procedures

The File – Recent Items selection enables you to 
choose a treatment plan you have reviewed 
recently.

� Click on or place your cursor over the Recent 
Items selection in the File menu to show the 
names of treatment plans you reviewed 
recently.

Figure 45. File – Recent Items menu
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Exporting a Movie

Menu Concepts

The Export – Movie dialog enables you to create a 
standalone movie that shows the ClinCheck 
animation. You can use this movie, for example, to 
show patients how their treatment will progress, or 
to enable them to share their anticipated before 
and after smile with their friends and family.

Dialog Procedures

Figure 47. Export – Movie Settings dialog

1. Select the view you want to show in the movie. 
The default is to show the animation for the 
current displayed view. If you want to show the 
animation for a preset view, click on the Preset 
View button, and then click on the view.

2. Select the stages you would like to animate. 
Drag the left triangle beneath the staging bar 
to the stage where you want to start the movie. 
Drag the right triangle the stage where you 
want to stop the movie. The default is to create 
the movie from the beginning stage to the last 
stage.

3. Select the movie size, depending on how big 
you want the movie to appear on your 
computer’s screen. The default is medium.

4. Select the animation speed. This setting 
determines the length of the movie. The center 
setting is the default. 

5. Check the Display Patient Information and/or 
the Display Clinician Information boxes if you 
want to display this information in the movie. 
For more information, see Specifying Display 
Settings. The default is to omit this information 
from the movie.

6. Click on the Create Movie button.

Figure 46. Export – Movie selection
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Exporting Screenshots

Menu Concepts

The Screenshot selection on the Export menu 
enables you to capture a picture of the ClinCheck 
3-D model and save it to a folder on your 
computer. This allows you to store, view, and 
email the picture.

Dialog Procedures

Figure 49. Saving a screenshot of the 3-D model

The file name for your screenshot appears 
automatically in the Filename field.

1. Ensure that Save as type is set to JPEG.

2. Click on the Save button.

Figure 48. Export – Screenshot selection
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Dialog Procedures

Figure 50. Screenshot displayed in your browser

1. Open the file where you saved the snapshot 
on your computer. You will see an icon of your 
screenshot whose name ends in .jpg. A large 
picture of your screenshot appears 
automatically in your browser. 

2. If you have more than one file stored in the 
folder, double-click on the icon for the 
screenshot you want to view and the 
screenshot displays in the browser.
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Advanced Tools Buttons

Buttons Concepts

Figure 51. Buttons for Advanced Tools

The Advanced Tools buttons appear on the 
ClinCheck toolbar only when you mark the 
appropriate selections on the Advanced Tools 
menu.

� Grid – Displays a grid used for performing 
linear tooth movement.

� Superimposition – Enables you to 
superimpose the tooth position at any stage in 
relation tooth position at any other stage.
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Using the Grid Capability

Example Grid Button

Figure 52. Facial grid with grid tool shown

The Grid button enables you to display a grid that 
can be used to measure linear tooth movements. 
For more information, see Using the 
Superimposition Capability.

Note: The grid does not provide the ability to 
measure angular movements such as rotation.
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Grid Dialog Concepts and Procedures

1. To gain access to the grid dialog, click on the 
down arrow on the Grid button. The grid dialog
enables you to set the orientation of the grid 
and the grid scale. 

2. Select one of the orientations from the 
Orientation list.

Orientation Used to Measure

Facial (frontal) Amount of intrusion, 
changes in midline, 
and posterior torque

Sagittal (anterior-
posterior; profile)

Amount of anterior-
posterior change, and 
anterior torque

Occlusal Amount of expansion 
and arch symmetry

3. Select your preferred measurement system 
(millimeters or inches).

4. Set Scale to choose the number of inches or 
millimeters between grid lines.

5. Click the check box to display the grid tool.

Figure 53. Grid dialog
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Using the Grid Tool Concepts and Procedures

Figure 54. Grid tool

The grid tool (red, green, and blue object) controls 
the grid position.

Figure 55. Moving the grid tool and the grid

� To activate the grid tool, click on the vertical or 
horizontal sections of the grid tool. The color of 
the section becomes brighter. 

� To rotate the grid, click and drag the grid tool 
section.

� Without using the grid tool, click anywhere on 
the grid and drag the grid to the desired 
location.
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Using the Grid Tool Concepts and Procedures

Figure 56. Moving the grid closer

� To move the grid closer to you, click on the 
center point of the grid tool, then drag the tool 
upward.

Figure 57. Moving the grid away

� To move the grid away from you, click on the 
center of the grid tool, then drag the tool 
downward.
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Using the Superimposition Capability
The superimposition capability enables you to visualize relative tooth movement during treatment.
Generally, you view superimposition between the initial and final tooth positions, but you can view 
superimposition between any two stages.

This capability enables you to view intrusion, extrusion, expansion, rotation, proclination, and retraction.

Tooth surfaces that become white (by default) are moving toward you. Tooth movements away from 
you are more difficult to see; however, if you increase the transparency, you are better able to see the 
tooth movement away from you. For more information on setting transparency, see Figure 59.
Superimposition dialog.

Superimpostition Example Concepts

Figure 58. Model with superimposition

The Superimposition button enables you to 
superimpose the tooth position at any stage in 
relation tooth position at any other stage. 
Typically, you view superimposed initial and final 
stages.
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Superimposition Dialog Concepts

Figure 59. Superimposition dialog

The Superimposition dialog enables you to set the 
stage at which you want to show all teeth as blue. 
The default stage is zero – all the teeth are blue. 

As you play the ClinCheck animation, teeth and 
tooth surfaces become white as they move toward 
you. 

This tool enables you to visualize how teeth move 
forward or backward, expand, or rotate. For 
example, with default setting 0, a tooth that is 
mostly white with a blue side edge shows that the 
tooth has rotated.

You can also set the transparency of the blue 
color. Low transparency shows a darker color. 
High transparency shows a lighter color. The 
default is half way between Low and High.
Increasing transparency improves your ability to 
view teeth or surfaces of teeth moving away from 
you.

Advanced usage: If you choose the last stage as 
blue, all teeth at stage 0 are white. As you play the 
ClinCheck animation, teeth and tooth surfaces 
become blue as they move away from you. 
Instead of playing the entire ClinCheck animation, 
you can move the slider to any stage and see the 
superimposed image at that stage.
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Using Superimposition and the Grid Concepts

Figure 60. Using superimposition and the grid to 
measure proclination of the right upper lateral 
tooth

The following example shows how to use
superimposition along with the grid to take 
measurements of tooth movement. The gray 
areas of the teeth represent tooth position at stage 
0. The white areas represent the tooth position at 
the final stage.

The grid is positioned to measure the model in the 
upper occlusal view. The red circle shows an area 
in which the left upper lateral tooth has proclined 
(moved forward) by 4 mm. The distance is 
measured between the edge of the white area and 
the edge of the gray area.
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Using the Attachments Interface
The Attachments Interface is an easy-to-use software tool that enables you to add attachments to a 
treatment plan.

Menu Procedure

� To enable the Attachments Interface feature, 
check Custom Attachments on the Advanced 
Tools menu.

Figure 61. Custom Attachment selected on the 
Advanced Tools menu
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Attachments Link Concepts and Procedures

Figure 62. Attachments link on the Changes panel

The Attachments link appears on the Changes 
panel.

� To open the Attachments Interface, click on 
the Attachments link.
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Pre-placed attachmentMissing Tooth

Trash Bin Attachment Types
Reset 
Button

Back 
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Show 
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Figure 63. Symbols and Buttons on the Attachment Interface
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The Attachments Interface displays the following symbols and buttons:

Symbol/Button Description

Trash bin When you want to discard an attachment, drag it 
into the trash bin.

Attachment types Different attachments that you can drag and drop 
onto teeth. The attachments you place display in 
yellow.

Pre-placed attachments The pre-placed attachments are displayed in gray.

Missing tooth A blue X mark indicates a missing tooth.

Back button Closes the Attachments Interface and opens the 
Changes panel.

Reset button Removes all attachment types you have placed.

Show lingual Shows the lingual side of the teeth. The default
view is the buccal side.
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Drag and Drop Procedures

Figure 64. An attachment dropped onto tooth 3

� Drag and drop an attachment type onto a 
tooth. Note that you cannot add optimized 
attachments.

Attachment Sizing Procedures

Figure 65. Attachment Size Selection dialog

1. To select a size for a vertical or horizontal 
rectangular attachment, click on the 
attachment.

2. In the Attachment Size Selection dialog, click 
on an attachment size, and then click on the 
OK button. If you do not select a size, the 
attachment size will be the default, which is 
“best fit.”
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Viewing Changes Procedures

Figure 66. Attachment additions included on the 
Changes panel

1. To see the effect of your changes, click on the 
Changes tab. Note that your additions appear 
in the second section of the Changes panel.

2. To return to the Attachments Interface, click on 
the Attachments link.
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Deleting an Attachment Procedures

Figure 67. Moving an attachment to the trash bin

� To delete an attachment, drag and drop it into 
the trash bin.

Figure 68. Attachment is removed

� Notice how the attachment on tooth 4 has 
disappeared.
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Resetting the Treatment Plan Procedure

Figure 69. Reset button on the Attachments 
Interface

� To remove the attachments you have placed 
and return to the original treatment plan, click
on the Reset button.
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Showing Lingual Surfaces Procedures

Figure 70. The Show Lingual button

� To view the lingual side of the teeth, click on
the Show Lingual button.

Figure 71. View of the lingual side of the teeth

1. To add attachments, drag and drop an 
attachment type to a tooth. 

2. Click on the Changes tab to see the results of 
the additions you have made. To return to the 
Attachments interface, click the Attachments 
link.

3. To return to the buccal view, click on the 
Buccal View button.
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Using the Precision Cuts Interface
The Precision Cuts interface is an easy-to-use software tool that enables you to specify how and where 
to cut aligners for Class II and Class III treatments.

Menu Procedure

� To enable the Precision Cuts feature, check 
Precision Cuts on the Advanced Tools menu.

Figure 72. Precision Cuts selected on 
the Advanced Tools menu
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Precision Cuts Link Concepts and Procedures

Figure 73. Precision Cuts link on the Changes 
panel

The Precision Cuts link appears on the Changes 
panel

� To open the Precision Cuts Interface, click on 
the Precision Cuts link.
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Figure 74. Precision Cuts Interface
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The Precision Cuts Interface displays the following symbols and buttons:

Symbol/Button Description

Trash bin When you want to discard an elastic hook or 
button cutout, drag and drop it into the trash bin.

Button cutout A cutout object that you can drag and drop onto a 
tooth to request a cutout in the aligners to 
accommodate a button on a tooth.

Elastic hooks A hook object that you can drag and drop onto a 
tooth to request an elastic hook on the aligner.

Missing tooth A blue X mark indicates a missing tooth.

Back button Closes the Precision Cuts Interface and opens the 
Changes panel.

Reset button Removes precision cuts you have specified.

Show lingual Shows the lingual side of the teeth. The default 
view is the buccal view.
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Drag and Drop Procedure

Figure 75. Placement of elastic hooks and button 
cutouts

� Drag and drop a button cutout or elastic hook 
onto a tooth.
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Viewing Changes Procedures

Figure 76. Precision Cuts additions included on the 
Changes panel

1. To see a text version of your changes, click 
on the Changes tab. Note that your 
additions appear in the second section of 
the Changes panel.

2. To return to the Precision Cuts Interface, 
click on the Precision Cuts link.



Align Technology, Inc. 65 Invisalign ClinCheck 3.0 User Guide

Deleting a Precision Cut Procedures

Figure 77. Moving a precision cut to the trash bin

� To delete a precision cut, drag and drop it into 
the trash bin.

Figure 78. Elastic hook on tooth 6 deleted

� Notice how the elastic hook on tooth 6 has 
disappeared.

Figure 79. Replacing the cut

� To replace the cut, drag and drop an elastic 
hook onto tooth 6.
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Reset Procedure

Figure 80. The Reset button on the Precision Cuts 
Interface

� To remove the Precision Cuts you have made 
and return to the original treatment plan, click
on the Reset button.
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Showing Lingual Surfaces Procedures

Figure 81. The Show Lingual button

� To view the lingual side of the aligners, click
on the Show Lingual button.

Figure 82. View of the lingual side of the aligners

1. To add Precision Cuts, drag and drop
button cutouts to a tooth.

2. Click on the Changes tab to see the results 
of the additions you have made. To return 
to the Precision Cuts Interface, click on the 
Precision Cuts link.

3. To return to the buccal view, click on the 
Buccal View button.
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Viewing Staging

Panel Concepts

Figure 83 : Staging panel showing overcorrection 
and passive aligner

Clicking on the Staging tab opens the Staging 
panel. The purpose of this panel is to show a 2-
dimensional version of the treatment plan per 
tooth. When you plan the ClinCheck animation, a 
vertical line sweeps across the Staging panel to 
help you see the state of the treatment at every 
stage.

� The numbers on the left and right sides of the 
panel indicate the tooth number.

� The numbers at the top of the panel indicate 
the stage number.

� The horizontal lines indicate the type of aligner 
used.

� Blank spaces in a line means that there is no 
movement planned in the aligner for the tooth 
at that particular stage.

Horizontal Line Color Type of Aligner

Blue Active aligner

Gray Passive aligner

Brown Overcorrection
aligner
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Symbols indicate the event that happens at a particular stage.

Symbol Event at a Particular Stage

IPR 

White Planned IPR

Yellow IPR complete by the 
current stage

Gray IPR finished

Note that the IPR colors change as the staging 
line sweeps across the panel.

Attachments placed

Attachments removed
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Using Keyboard Shortcuts
You can use keyboard shortcuts to translate and rotate the model, and to zoom in and zoom out.

Using the Keyboard and Mouse

� Position your cursor over the 3-D model.
� To translate the model, press and hold the Shift key while moving the mouse in the direction you 

want the model to move.
� To zoom in or zoom out, press and hold the Ctrl (Control) key while moving the mouse up or down. 

Using the Keyboard Only

� To zoom in or zoom out, press Ctrl (Control) while you press one of the directional arrows on your 
keyboard. Press up or right to zoom in. Press down or left to zoom out.

� To rotate the 3-D model, press Shift and one of the directional arrows on your keyboard (up, down,
left, or right).

Working Offline
The primary way to gain access to ClinCheck treatment plans is online, on the Invisalign Doctor Site, 
but you can also work offline (without an internet connection) with the Invisalign Patients Viewer. 

Note: When you work offline, you will not be able to submit changes or approve a ClinCheck treatment 
plan.

When you open a ClinCheck treatment plan online on the Invisalign Doctor Site, the treatment plan is 
saved locally on your computer in the Invisalign Patients Viewer. This viewer is installed on your 
desktop when you install the ClinCheck software. The Invisalign Patients Viewer displays a list of 
ClinCheck treatment plans stored on your computer – samples supplied by Invisalign in addition to your 
treatment plans.

� To open the Invisalign Patients Viewer from the desktop, double-click on the Invisalign Patients 
Viewer icon on your computer’s desktop.

� To open the Invisalign Patients Viewer from the Start menu on your computer, select All Programs, 
then Align, followed by ClinCheck 3.0, and Invisalign Patients Viewer.

� To open a treatment plan, click once on the bar beneath the patient’s name. For sample treatment 
plans, click on the bar beneath the treatment name.
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Treatment Plan Review with Invisalign Assist
Reviewing a ClinCheck treatment plan for the Invisalign Assist® option is similar to reviewing a 
ClinCheck treatment plan for the Invisalign Full option. The differences are presented in this section.

Cancelling an Invisalign Assist Treatment

Buttons Concepts and Procedures

Figure 84. Cancel and Approve buttons in 
Invisalign Assist

� To approve a ClinCheck treatment plan, click
on the Approve button. This process is the 
same as the process to approve an Invisalign 
Full treatment plan. 

� You have 3 other choices: Cancel, Switch, and 
Refer. 

o Cancel stops the treatment plan review 
process. No aligners are manufactured.
For any cancellations, you are not 
responsible for payment

o Switch enables you to change to a 
different treatment option, such as 
Invisalign Full.

o Refer enables you to refer a patient to a 
different doctor.
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Using the Animation Control Bar for ClinCheck Animation

Animation Control Bar Concepts and Procedures

Figure 85. Animation Control Bar in Invisalign 
Assist

On the Animation Control Bar, the scrubber does 
not include numbers, nor does the area to the right 
of the animation bar controls. This is because 
progress tracking might result in some changes to 
ClinCheck staging.

The process of playing the ClinCheck animation is 
the same as the process of playing an animation
in the Invisalign Full interface – using the 
animation controls.

� Drag the scrubber to any location on the 
animation control bar to see the estimated 
tooth position. 
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Using the Treatment Panel

Treatment Panel Concepts

Figure 86. Invisalign Assist treatment panel

The Treatment Panel shows the following:

� An overview of the treatment, which includes:
� IPR and attachments needed in treatment
� Aligner features included in the treatment
� Guidance on tasks to perform at each patient 

appointment
At the top of the panel, there are links for each 
appointment. When you click on a link, the 
scrubber moves to the location on the animation 
control bar for that appointment and the ClinCheck 
model moves to the estimated tooth position for 
that appointment.
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Staging Panel Inactive

Panel Concepts and Procedures

Figure 87. Inactive staging tab

Because progress tracking is an integral part of 
Invisalign Assist, the treatment plan might change. 
Specific stage information including stage 
numbering is not displayed, so the staging panel is 
not needed.
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Advanced Tools Inactive

Panel Concept

Figure 88. Attachments and Precision Cuts links 
inactive on Changes panel

If you previously selected Custom Attachments or 
Precision Cuts on the Advanced Tools menu, then
the links are disabled on the Changes panel.
These features are not available for the Invisalign 
Assist treatment option.
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Configuration Requirements
System Requirements
In order to view ClinCheck treatment plans and return feedback to Invisalign, you must have internet 
access and your computer should meet the minimum specifications below.

Note : The ClinCheck software currently runs only on the PC platform: Windows XP SP2, XP SP3; 
Vista (any SP); Windows 7; Server 2003 SP2 or RC2; and Server 2008 SP2 or RC2.

Hardware Requirements

Minimum Requirements Recommended

� Intel® Pentium 4™, 1.6 GHz or compatible
� 512 MB RAM
� Minimum of 1 GB free disk space
� High-Speed Internet (DSL, Cable Modem, or 

equivalent)
� Acceleration technology supporting 3-D

graphics via Open GL. Add-on graphics card 
with 128 MB of dedicated (unshared) memory, 
or integrated video chipset.

� Intel® Pentium 4™, 3.2 GHz, Intel Core 2 Duo 
2.0 GHz or compatible

� 1024 MB RAM or more
� Minimum of 2 GB free disk space
� High-Speed Internet (DSL, Cable Modem, or 

equivalent)
� Acceleration technology supporting 3-D

graphics via Open GL. Add-on graphics card 
with 256 MB of dedicated (unshared) memory, 
or integrated video chipset.

Software Requirements

Minimum Requirements Recommended

� Windows XP SP2, 32-bit

� Internet Explorer 7

� 1024x768 Display Resolution

� 32 Bit True\Color Palette Settings

� Adobe Acrobat Reader Version 9 (New)

� Graphics driver not older than 1 year

� Windows XP SP 3 or Windows Vista

� Internet Explorer 7 or above

� 1024x768 display resolution or higher

� 32 Bit True\Color Palette Settings

� Adobe Acrobat Reader Version 9 (New)

� Latest graphics driver

Additional Software Requirements

� Administrator rights for installation
� Read / Write access to the C:\Program Files\Align folder and ALL subfolders
� ActiveX allowed on local system
� Activated SSL 3
� Protection hardware/software must be configured accordingly to allow the Invisalign Doctor Site to 

send / receive data (allow port 80 for http and port 443 to https for inbound and outbound)
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� No toolbars – or need to be configured accordingly
� Cookies enabled for Internet Explorer
� Third-Party Plugins/Add-ons allowed in Internet Explorer
� Windows Vista: The ClinCheck software was tested on Windows Vista under a specific 

configuration. Ensure you install the latest graphics drivers. Also, there are known issues with the 
visual artifacts when running Intel video chipsets.

� You must be log in with administrative rights
If you are unfamiliar with how to set up your Security Settings, refer to the Internet Explorer 6 Setting 
Up Security Zones (http://www.microsoft.com/windows/ie/ie6/using/howto/security/setup.mspx) Web 
site.

Administrator Requirements
Before beginning installation, ensure that you have Administrator rights on your computer.

1. On your desktop, right-click My Computer, and then select Manage.

2. In the left pane, expand System Tools, and then click on Local Users and Groups.

3. In the right pane, double-click Groups.

4. Double-click Administrators. If your name appears in Members you have Administrator rights. 

5. If you do not have Administrator rights, have your Administrator assign you Administrator rights. 

Adobe Acrobat Reader Version 9 Requirements
1. Open a browser window and go to http://adobe.com.

2. Download Acrobat Reader Version 9 (or higher) from this website.

Pop-up Blocker Requirements
The ClinCheck software relies on several pop-up windows to function. If you have pop-up blocking 
software installed it may prevent ClinCheck and other VIP tools from operating correctly. Many pop-up
blockers are available commercially. These pop-up blockers can be configured to allow pop-ups from 
specific websites. Consult the pop-up blocking software help files for more information on how to 
configure this feature. Usually you will need to indicate a root URL in your configuration to allow pop-
ups from specific web sites. Use the following values to configure the ClinCheck software:

� http://*.aligntech.com
� http://*.invisalign.com
As an alternative to configuring your pop-up blocking software, you may choose to turn off any pop-up
blocker when using ClinCheck to avoid a conflict. 

Internet Explorer Requirements
The ClinCheck software is designed to work with the default security settings for Microsoft Internet 
Explorer. If your browser security settings have been changed you may not be able to access the 
ClinCheck software. Follow the steps below to check your settings and return the security settings to 
their default level:

1. Open Microsoft Internet Explorer.

2. From the Tools menu select Internet Options.
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3. Select the Security tab.

4. Select Trusted Sites.

5. Click the Sites button. 

6. Click inside Add this website to the zone:

a. Type https://*.invisalign.com and click the Add button. 

b. Type https://*.aligntech.com and click the Add button.

7. Click Close.

8. Click OK.

9. Close Microsoft Internet Explorer.

Anti-Virus Software Requirements
You must configure your anti-virus software if it is installed in your computer to allow the ClinCheck
software to communicate with the servers running the Invisalign service. For information about 
configuring your anti-virus software, ask your computer support technician or contact Align Customer 
Care. You can find information about Align Customer Care on the Support page on the Invisalign 
Doctor Site. 

Graphics Driver Requirements
The ClinCheck software displays 3D models that require up-to-date graphics drivers. To obtain help 
installing the graphics driver software, ask your computer support technician or contact Align Customer 
Care. You can find information about Align Customer Care on the Support page on the Invisalign 
Doctor Site.
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Installing the ClinCheck Software
Automatic Download for Existing Users
Respond to offer for update When a new version of the ClinCheck software is 

available, a pop-up dialog will display, asking you 
whether to install the new version.

� Click Yes.

Downloading the ClinCheck Software

Install the ClinCheck software from the Invisalign 
Doctor Site

1. Log into the Invisalign Doctor Site.

2. Click on the Support tab.

3. Click on the Software download link and 
download the ClinCheck software.

Installation for New Users

Install the ClinCheck software from the CD 1. Insert the Invisalign software bundle installer
CD into your CD drive. This is the CD you 
received in the Clear Essentials I course. The
InstallShield Wizard dialog box displays.

2. Follow the on-screen instructions and begin 
using the ClinCheck software.

Complete the ClinCheck software installation A window displays asking you if you want to view 
documents.

1. Select the documents that you want to view, 
and click on the OK button.

2. When the documents display, read them. Print 
them, if desired.

3. Close the documents.

4. If you chose Open Invisalign Patients, the 
Invisalign Patients Viewer opens.

5. If you did not choose Open Invisalign Patients,
open a treatment plan from the Invisalign 
Doctor Site.
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Installing the ClinCheck Software on a Network
You can set up a single Invisalign Patients Viewer for access by multiple computers and users on a 
network. By default, an Invisalign Patients Viewer is installed on each local machine where the 
ClinCheck software is installed. You must install the ClinCheck software on each computer in the 
network; however, all those computers will have the ability to share a common, centralized Invisalign 
Patients Viewer.

1. Install the ClinCheck software on the computer where you want to locate the Invisalign Patients 
Viewer.

2. Share the Invisalign Patients Viewer:

a. From your Start menu, select My Computer.

b. Click on Local Disc C.

c. Click on Program Files.

3. Click on Align. (The default location is C:\Program Files\Align)

4. Right click on the Invisalign Patients folder icon and select Properties.

a. Click the Sharing tab, and select Share This Folder. By default, the share name is Invisalign 
Patients.

b. Select the Security tab.

c. Click Add, and then add the Windows user accounts of all individuals who need access to 
the Invisalign Patients Viewer.

d. Click OK.

e. For each Windows user you have added, click on (highlight) the user’s name, then click the 
Permissions box in the Allow column to assign privileges for the user.

5. When you are finished with all users, click Apply.

6. To find the share name and computer where you installed the Invisalign Patients Viewer, complete 
the following steps:

a. In Windows, right click on the My Computer icon (or go to the Start menu and select My 
Computer) and select Properties.

b. Select the Computer Name tab. The full computer name is displayed here.

c. Write down the computer name. You will need this name for the next step.

d. Click OK.

7. Install the ClinCheck software on all computers that need access to the Invisalign Patients Viewer.

a. Use the installation instructions to install the ClinCheck software on each computer in your 
network. The Installation Wizard displays. Follow the onscreen instructions.

b. In the Choose Destination Location dialog, click Browse, then enter the Network Path of the 
Invisalign Patients Viewer you previously installed.

c. Enter the path as \\COMPUTERNAME\SHARENAME, where COMPUTERNAME is the 
name of your computer and the SHARENAME is “Invisalign Patients.”

8. Click the Next button and continue with the installation.


